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Thomson Reuters Precedents 

Drafting Aide Instructions 

Thomson Reuters Precedents have a document automation feature called the Precedents Drafting Aide (the Drafting 

Aide). The Drafting Aide is a Microsoft Word (MS Word) macro which has been specially created to help you draft and 

fill in form documents with speed and efficiency. 

You only install the Drafting Aide once on your computer, after which it is available every time you use MS Word. 

Contents 

1 Downloading the Drafting Aide installation file 

2 Installing the Drafting Aide into MS Word 

2.1 MS Word 2016 or later 

2.2 MS Word 2013 

2.3 MS Word 2010 

2.4 MS Word 2007 

2.5 MS Word 2003 

2.6 MS Word 2000 

2.7 MS Word 97 

3 Installation Troubleshooting 

3.1 I got to the end of the installation process, but when I restarted MS Word the Drafting Aide icon was not 

in the Add-ins tab (or in the Toolbar if using MS Word 2003 or earlier) 

3.2 I got to the end of the installation process, but when I restarted MS Word there was no Add-ins tab (MS 

Word 2007 or later) 

3.3 When I try to install the Drafting Aide, MS Word hangs/freezes 

3.4 I have Infinity Law and I can’t install the Precedents Drafting Aide 

3.5 Can I install the Drafting Aide on an Apple computer? 

4 Downloading and Opening a Precedent 

5 Using the Drafting Aide 

5.1 Launching the Drafting Aide 

5.2 Variables 

5.3 Navigation in the Drafting Aide 

5.4 Drafting Aide buttons 

5.5 Document reformat tools 

5.6 Tips/FAQs 

5.7 Troubleshooting 

 



2 

 

1 Downloading the Drafting Aide installation file 

The first step in installing the Drafting Aide is to download the installation file (Brkprcd4.doc). 

The instructions for downloading the installation file are the same regardless of whether you are using Westlaw New 

Zealand or Checkpoint New Zealand to access Thomson Reuters Precedents. 

 

(1) Close any email applications you have open (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Go to any Precedent and click on the Download and Install Drafting Aide link 

Westlaw New Zealand example: 
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Checkpoint New Zealand example: 

 

 

(3) Download the Drafting Aide installation file (Brkprcd4.doc) 

By default, the installation file will download to the Downloads folder on your computer. 

If prompted to do so, click on Open to open the file in MS Word and begin installation immediately. 

Alternatively, you can navigate to the Downloads folder (now or later) and open the file from there to begin 

installation. 

Return to top 
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2 Installing the Drafting Aide into MS Word 

Once you have downloaded the Drafting Aide installation file to your computer (from Westlaw New Zealand or 

Checkpoint New Zealand), the next step is to install the Drafting Aide into MS Word. 

Follow the instructions below for the version of MS Word you are using. 

 

Troubleshooting 

If you encounter any problems installing the Drafting Aide, check Installation Troubleshooting below 

OR 

Contact our ANZ TechCare team for assistance: 

Phone 0800 10 60 25  

Email TechCare.ANZ@thomsonreuters.com  

 

2.1 MS Word 2016 or later 

(1) Ensure any email applications on your computer are closed (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Open the Precedents Drafting Aide installation file Brkprc4.doc (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide above, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if you saved it elsewhere). 

Once you have found the file Brkprc4.doc, double-click on it to open it in MS Word. 

(3) Enable Content to allow the Drafting Aide to install 

When Brkprcd4.doc opens, you may see a security warning as below. Click on Enable Content to allow the 

Drafting Aide to install: 
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(4) Click OK to copy Brkprcd.dot to the MS Word startup path 

After clicking Enable Content the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the MS Word startup path. (This will make the Drafting Aide available every 

time you use MS Word.) 

(5) Click OK and restart MS Word to confirm the Drafting Aide has been installed 

After clicking OK to copy Brkprcd.dot to the MS Word startup path, you should see the dialog box below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

(6) After restarting MS Word, confirm that the Precedents Drafting Aide has been installed 

successfully 

Once MS Word has restarted, go to the Add-ins tab and look for the Drafting Aide icon as below: 

 

 

The Drafting Aide icon looks like this: 

 

If the Drafting Aide icon is in the Add-ins tab, then the installation was successful. 

 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw New Zealand or Checkpoint New Zealand, go 

to Downloading and Opening a Precedent below. 

Return to top 
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2.2 MS Word 2013 

(1) Ensure any email applications on your computer are closed (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide above, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if you saved it elsewhere). 

Once you have found the file Brkprc4.doc, double-click on it to open it in MS Word. 

(3) Enable Content to allow the Drafting Aide to install 

When MS Word 2013 opens, you may get a security warning as below. Click Enable Content to allow the 

Drafting Aide to install: 

 

(4) Copy Brkprcd.dot to the MS Word startup path 

After clicking Enable Content the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the MS Word startup path. (This will make the Drafting Aide available every 

time you use MS Word.) 
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(5) Click OK to complete installation and restart MS Word 2013 

After clicking OK to copy Brkprcd.dot to the MS Word startup path, you should see the dialog box below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

(6) After restarting MS Word 2013, confirm that the Drafting Aide has been successfully installed 

Once MS Word has restarted, go to the ADD-INS tab and look for the Drafting Aide icon as below: 

 

 

The Drafting Aide icon looks like this: 

 

If the Drafting Aide icon is in the ADD-INS tab, then the installation was successful. 

 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw New Zealand or Checkpoint New Zealand, go 

to Downloading and Opening a Precedent below. 

Return to top 

2.3 MS Word 2010 

(1) Ensure any email applications on your computer are closed (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide above, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if you saved it elsewhere). 

Once you have found the file Brkprc4.doc, double-click on it to open it in MS Word. 
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(3) Enable Editing to allow the Drafting Aide to install 

When MS Word 2010 opens, you may get a security warning as below. Click Enable Editing to allow the 

Drafting Aide to install: 

 

(4) Click OK to copy Brkprcd.dot to the MS Word startup path 

After clicking Enable Editing the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the MS Word startup path. (This will make the Drafting Aide available every 

time you use MS Word.) 

(5) Click OK to complete installation and restart MS Word 2010 

After clicking OK to copy Brkprcd.dot to the MS Word startup path, you should see the dialog box below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

(6) After restarting MS Word 2010, confirm that the Drafting Aide has been successfully installed 

Once MS Word 2010 has restarted, go to the Add-ins tab and look for the Drafting Aide icon as below: 

 

 

The Drafting Aide icon looks like this: 

 

If the Drafting Aide icon is in the Add-ins tab, then the installation was successful. 
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For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw New Zealand or Checkpoint New Zealand, go 

to Downloading and Opening a Precedent below. 

Return to top 

2.4 MS Word 2007 

(1) Ensure any email applications on your computer are closed (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide above, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if you saved it elsewhere). 

Once you have found the file Brkprc4.doc, double-click on it to open it in MS Word. 

(3) Enable the content to allow the Drafting Aide to install 

When MS Word 2007 opens, you may get a security warning as below: 

 

If so, click Options. The following dialog box will open: 

 

Select Enable this content and click OK. 

 



10 

(4) Click OK to Copy Brkprcd.dot to the MS Word startup path 

After clicking OK to Enable this content, the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the MS Word startup path. (This will make the Drafting Aide available every 

time you use MS Word.) 

(5) Click OK to complete installation and restart MS Word 2007 

After clicking OK to copy Brkprcd.dot to the MS Word startup path, you should see the dialog box below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

(6) After restart MS Word 2007, confirm that the Drafting Aide has been successfully installed 

Once MS Word 2007 has restarted, go to the Add-ins tab and look for the Drafting Aide icon as below: 

 

 

The Drafting Aide icon looks like this: 

 

If the Drafting Aide icon is in the Add-ins tab, then the installation was successful. 

 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw New Zealand or Checkpoint New Zealand, go 

to Downloading and Opening a Precedent below. 

Return to top 

2.5 MS Word 2003 

(1) Ensure any email applications on your computer are closed (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Open the Precedents Drafting Aide installation file (if not already open) 
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If you have just followed the instructions for downloading the Drafting Aide above, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if you saved it elsewhere). 

Once you have found the file Brkprc4.doc, double-click on it to open it in MS Word. 

(3) Click Enable Content to allow the Drafting Aide to install 

When MS Word 2003 opens, you may get a security warning: 

 

If so, click Enable Macros to allow the Drafting Aide to install. 

(4) Click OK to copy Brkprcd.dot to the MS Word startup path 

After clicking Enable Macros the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the MS Word startup path. (This will make the Drafting Aide available every 

time you use MS Word.) 

(5) Click OK to complete installation and restart MS Word 2003 

After clicking OK to copy Brkprcd.dot to the MS Word startup path, you should see the dialog box below: 

 

Click OK and restart MS Word (if it does not restart automatically). 
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(6) Restart MS Word 2003 to confirm the Drafting Aide has been successfully installed 

Check for the Drafting Aide icon in the Toolbar: 

 

If the Drafting Aide icon is on the Toolbar, then the Drafting Aide has been installed successfully. 

 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw New Zealand or Checkpoint New Zealand, go 

to Downloading and Opening a Precedent below. 

Return to top 

2.6 MS Word 2000 

(1) Ensure any email applications on your computer are closed (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide above, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if you saved it elsewhere). 

Once you have found the file Brkprc4.doc, double-click on it to open it in MS Word. 

(3) Completing installation 

When MS Word 2000 opens, you will see the words Precedents Drafting Aide. 
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You may need to change the security settings to allow the Drafting Aide to install. 

Click on the Tools menu at the top of the page, then on Macro and finally Security: 

 

When you click on Security, the Security dialog box will open: 

 

Select Low so you are able to install the Drafting Aide and then click OK. 

(4) Click OK to copy Brkprcd.dot to the MS Word startup path 

After clicking OK the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the MS Word startup path. (This will make the Drafting Aide available every 

time you use MS Word.) 
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(5) Click OK to complete installation and restart MS Word 2000 

After clicking OK to copy Brkprcd.dot to the MS Word startup path, you should see the dialog box below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

(6) After restarting MS Word 2000, confirm that the Drafting Aide has been successfully installed 

Look for the Drafting Aide icon in the Toolbar: 

 

If the Drafting Aide icon is in the Toolbar, then the installation was successful. 

 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw New Zealand or Checkpoint New Zealand, go 

to Downloading and Opening a Precedent below. 

Return to top 

2.7 MS Word 97 

(1) Ensure any email applications on your computer are closed (e.g. Outlook) 

Please note that having email applications open during installation may prevent the Drafting Aide from 

installing properly. 

(2) Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide above, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if you saved it elsewhere). 

Once you have found the file Brkprc4.doc, double-click on it to open it in MS Word. 
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(3) Complete installation 

When MS Word 97 opens, you may get a security warning (as you are about to install an MS Word macro): 

 

Click Enable Macros. (If you click Disable Macros the Drafting Aide will not install.) 

(4) Click OK to copy Brkprcd.dot to the Microsoft Word startup path 

After clicking Enable Macros the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the MS Word startup path. (This will make the Drafting Aide available every 

time you use MS Word.) 

(5) Click OK to complete installation and restart MS Word 97 

After clicking OK to copy Brkprcd.dot to the MS Word startup path, you will see the dialog box below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

(6) After restarting MS Word 97, confirm that the Drafting Aide has been successfully installed 

Look for the Drafting Aide icon in the Toolbar: 

 

If the Drafting Aide icon is in the Toolbar, then the installation was successful. 

 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw New Zealand or Checkpoint New Zealand, go 

to Downloading and Opening a Precedent below. 
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Troubleshooting 

If you encountered any problems installing the Drafting Aide, check Installation Troubleshooting below 

OR 

Contact our ANZ TechCare team for assistance: 

Phone 0800 10 60 25  

Email TechCare.ANZ@thomsonreuters.com  

 

Return to top 
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3 Installation Troubleshooting 

 

Additional help 

For additional help with troubleshooting, please contact our ANZ TechCare team: 

Phone 0800 10 60 25  

Email TechCare.ANZ@thomsonreuters.com  

 

3.1 I got to the end of the installation process, but when I restarted MS Word the 

Drafting Aide icon was not in the Add-ins tab (or in the Toolbar if using MS 

Word 2003 or earlier) 

3.1.1 MS Word 2013 or later 

(1) Click on the File tab. 

(2) Click on Options: 
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(3) Click on Add-ins, then select Word Add-ins from the drop-down menu at the bottom of the window 

and click Go: 

 

(4) Check in the list of Global templates and add-ins for the file name brkprcd.dot: 

 

If the checkbox next to the file name brkprcd.dot is not ticked, tick it and click OK. 
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(If the checkbox is not ticked, this causes either (a) the Add-ins tab to not appear or (b) the Drafting 

Aide icon to not appear in the Add ins tab.) 

(5) Restart MS Word. After you restart MS Word: 

• The Add-ins tab should appear (if it was not there before). 

• The Drafting Aide icon should appear in the Add-ins tab. 

3.1.2 MS Word 2010 

(1) Click on the File tab. 

(2) Click on Options: 

 

(3) Follow instructions (3)–(5) as for MS Word 2013 or later above. 
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3.1.3 MS Word 2007 

(1) Click on the File tab. 

(2) Click on Word Options: 

 

(3) Follow instructions (3)–(5) as for MS Word 2013 or later above. 

3.1.4 MS Word 2003 or earlier 

(1) Click on the Tools tab. 

(2) Click on Templates and Add-ins in the Tools menu. 

(3) Follow instructions (3)–(5) as for MS Word 2013 or later above. 

(4) Once you have followed these instructions, the Drafting Aide icon should appear in the Toolbar. 

Return to top 

3.2 I got to the end of the installation process, but when I restarted MS Word there 

was no Add-ins tab (MS Word 2007 or later) 

Follow the instructions in [3.1] above. 

Return to top 

3.3 When I try to install the Drafting Aide, MS Word hangs/freezes 

The Drafting Aide has been tested and successfully installed in all versions of MS Word from MS Word 97. 

If MS Word freezes or hangs during installation, it is possible there is something in your own IT environment 

that is preventing the Drafting Aide from installing successfully. 
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Please contact our ANZ TechCare team (phone 0800 10 60 25 or email TechCare.ANZ@thomsonreuters.com) 

or your own IT support (if you have any) if you need help to troubleshoot such problems. (Support with MS 

Word is also available directly from Microsoft: see https://support.microsoft.com/.) 

Some things an IT support person can check are: 

• Was there an email application that was open when the Drafting Aide was being installed? 

• Are the latest MS Word updates installed? (There may be an issue that has been resolved in a recent 

update.) 

• Are there incompatible Add-ins installed in the copy of MS Word you are using? (If so, it may be 

necessary to disable these before installing the Drafting Aide — see instructions under [3.4] below.) 

• Are there security settings set up by your IT systems administrator (e.g. which block you from 

installing a macro) that might be preventing the Drafting Aide from installing? 

• Are there any other software/operating system conflicts causing MS Word to freeze/hang? (Check if 

any other new software has been installed recently that might be causing conflicts; or check 

Microsoft support forums for any known conflicts: https://support.microsoft.com/.) 

Return to top 

3.4 I have Infinity Law and I can’t install the Precedents Drafting Aide 

There is a conflict between Infinity Law’s MS Word add-in and the Precedents Drafting Aide add-in, which may 

interfere with installing the Precedents Drafting Aide. This conflict can be worked around by disabling the 

Infinity Law add-in during the installation process (the Infinity Law add-in will come back automatically the 

next time MS Word is started): 

(1) Close MS Word if it is open. 

(2) Open MS Word in “Safe mode” as follows: 

• Press the CTRL key at the same time as double-clicking on the MS Word icon document, or on a 

MS Word document (which can be any MS Word) document. 

• You should get a message like this: 

 

 

mailto:TechCare.ANZ@thomsonreuters.com
https://support.microsoft.com/
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When MS Word opens in safe mode, there should be something at the top of MS Word confirming that it 

is open in safe more: 

  

• When you have confirmed that MS Word is open in safe mode, start the installation process 

again. Either: 

o download the file Brkprcd4.doc again (see Downloading the Drafting Aide installation file 

above); or 

o find the file Brkprcd4.doc in your Download folder and double-click on it to open MS 

Word. 

• Follow the instructions for installing the Drafting Aide (see Installing the Drafting Aide into MS 

Word above). 

• After installing, restart MS Word. The Drafting Aide should be in the Add-ins tab and work as 

normal (assuming there is nothing else other than Infinity Law interfering with the process). 

Return to top 

3.5 Can I install the Drafting Aide on an Apple computer? 

While Thomson Reuters Precedents are not compatible with Apple computers, if the user is running Windows 

emulation software, both the Precedents and the Precedents Drafting Aide should run as normal inside the 

emulated Windows environment. 

Return to top 

 

 

Additional help 

For additional help with troubleshooting, please contact our ANZ TechCare team: 

Phone 0800 10 60 25  

Email TechCare.ANZ@thomsonreuters.com  
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4 Downloading and Opening a Precedent 

(1) Click on the Precedent Type link (in Westlaw New Zealand) or Tool Type link (in Checkpoint New 

Zealand) of the target Precedent 

Westlaw New Zealand example: 

 

 

Checkpoint New Zealand example: 
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(2) Download the Precedent 

By default, the file will download to the Downloads folder on your computer. 

If prompted to do so, click on Open to open the file in MS Word and use the Precedent immediately. 

Alternatively, you can navigate to the Downloads folder (now or later) and open the file from there. 

(3) Open the Precedent and (if required) enable editing 

When the Precedent opens, you may get a security warning asking if you wish to enable editing, for example: 

 

If so, enable editing (to allow you to use the Precedent). 

 

Continue to the instructions for Using the Drafting Aide below. 

 

 

Troubleshooting 

If you encounter any problems downloading and opening a Precedent, contact our ANZ TechCare team for assistance: 

Phone 0800 10 60 25  

Email TechCare.ANZ@thomsonreuters.com  

 

Return to top 
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5 Using the Drafting Aide 

 

Training & Support 

For additional help with using the Drafting Aide, our Trainers can assist. You can request help through the Training & 

Support website: 

https://support.thomsonreuters.co.nz/  

The Training & Support website also offers resources such as user guides, FAQs, tips, videos and webinars. 

 

5.1 Launching the Drafting Aide 

5.1.1 Drafting Aide icon 

After opening a Precedent, launch the Drafting Aide by clicking on the Drafting Aide icon: 

 

 

The Drafting Aide icon is in the Add-ins tab (MS Word 2007 or later) or in the Toolbar (MS Word 2003 or 

earlier): 
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When you click on the Drafting Aide icon, the Drafting Aide will open as a dialog box: 

 

5.1.2 Drafting Aide version 

The first time you use the Drafting Aide, check that the Drafting Aide is the latest version. The current version 

is v4.02: 

 

5.1.3 Moving the Drafting Aide dialog box 

The Dialog Box may be moved from its current position on the screen by holding down the left mouse button 

on the dialog box title bar (labelled Precedents Drafting Aide v4.02) and dragging the dialog box to a new 

position on the screen. 

Return to top 

5.2 Variables 

Variables are the bits of information you enter in a Precedent (e.g. [1=company name], [2= address] and 

so on); they are called “variables” because they vary each time you use the Precedent. The variables appear 

in blue italicised text in the Precedent. 

The Drafting Aide will take you through all the variables in a Precedent and allow you to fill in each piece of 

information one by one, without you having to type in the document itself; the Drafting Aide automatically 

inserts whatever you have typed or selected into the correct place(s) in the document. 

Where a variable occurs several times in a Precedent, you only need to type in the information once and it will 

be copied automatically to all the places in the Precedent where it appears. 
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The Thomson Reuters Precedents documents contain several types of variables. 

5.2.1 Information variables 

An information variable prompts you to type in certain information. For example: 

 

[3=occupation] 

5.2.2 Choose-text variables 

A choose-text variable prompts you to choose which piece of text from a list you wish to insert. For 

example: 

 

[6=filing  OR  hearing] 
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5.2.3 Option variables 

An option variable prompts you to include or exclude certain text/information. For example: 

 

 

5.2.4 Suboption variables 

A suboption variable is a further option within an option. For example: 
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5.2.5 Choice variables 

A choice variable prompts you to choose between two (or more) sections of text/information (these sections 

can be just a phrase or several sentences/paragraphs in length), where you can only include one of the 

alternative selections. For example: 

 

 

5.2.6 Subchoice variables 

A subchoice variable is a further choice within a choice. For example: 

 

 

Return to top 
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5.3 Navigation in the Drafting Aide 

5.3.1 Keyboard navigation 

• TAB: use the TAB key to navigate your way through the available options on the dialog box. 

• ENTER: use the ENTER key to execute the selected button or to insert your typed text. 

• SPACE: use the SPACE key to execute the selected button. 

• CTRL + ENTER: this will create a new line when entering text. 

• ARROW keys: use the ARROW keys to navigate between different choices in the variable information 

box. 

• SHORTCUT keys: each button has its own shortcut keys — place your mouse over the button to see the 

keys required or refer to the list below. 

Please note: When using Word 2000, the text in the Precedents Drafting Aide may not be automatically 

highlighted. To overcome this, simply press the TAB key and the text will be automatically highlighted. 

5.3.2 Mouse navigation 

• Single click: using the left mouse button, a single click will execute the required button or place the 

cursor in the input box. 

Return to top 

5.4 Drafting Aide buttons 

There are eight buttons in the Drafting Aide, plus scrolling options. Click on the button icons below to jump to the 

explanation for that button: 

        

 

5.4.1 YES/OK button (ALT + Y) 

The YES button will replace the highlighted variable with either your text or your selected option or choice. 
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5.4.2 NO/DELETE button (ALT + D) 

The NO button will remove the highlighted text from the document, including the preceding space if 

appropriate. 

 

5.4.3 SKIP button (ALT + K) 

The SKIP button will skip the highlighted variable and then locate and highlight the next available variable. 

 

5.4.4 BACK button (ALT + J) 

The BACK button will allow a user to modify a previously completed variable. 
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5.4.5 LEAVE BLANK button (ALT + B) 

The LEAVE BLANK button will replace the highlighted variable with one of the three available spaces: 2 cm, 6 

cm and 12 cm. 

 

5.4.6 STOP button (ALT + S) 

The STOP button will close the Precedents Drafting Aide. 
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5.4.7 DOCUMENT REFORMAT button (ALT + T) 

 

The DOCUMENT REFORMAT button will present a pop-up box with several tools for reformatting the 

document. (This box will also pop up automatically when there are no more variables to fill, or if you exit out 

of the Drafting Aide.) 

 

 

The tools are explained at [5.5] below. 

5.4.8 HELP button (ALT + H) 

This button will open the Help information. 
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5.4.9 SCROLL options (small or large) 

This feature allows you to toggle between scrolling through the document in small steps (the default) or larger 

steps while the Drafting Aide continues to run. Click on the dot to toggle between the two scrolling options. 

 

Return to top 

5.5 Document reformat tools 

When all the variables in a Precedent have been filled, or if the user exits out of the Drafting Aide (using the 

STOP button), the Document reformat dialog box will open automatically: 

 

 

As noted at [5.4.7] above, these tools may also be accessed while using the Drafting Aide by pressing the 

DOCUMENT REFORMAT button: 

 

 

Each tool is explained below. 
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5.5.1 Import styles from another document 

This tool will allow the user to import formatting styles from another document. 

If Import styles from another document? is selected, when you click the PLAY button at the bottom of the 

dialog box you will be taken to the documents folder to select a document from which you would like styles to 

be imported. 

Browse to the document you would like to use, select that document and then click Open. The styles from 

that document will then be imported into the Precedent (this may take a few moments). 

 

5.5.2 Remove editorial notes 

This tool will remove all instances of green italicised editorial notes and any external logos or graphics present 

in the document. 

5.5.3 Change all text to normal text 

This tool will change the style of variable text from blue/italicised to black/non-italicised. 

5.5.4 Renumber paragraphs 

This tool allows users to renumber labelled paragraphs (and subparagraphs) automatically after adding or 

removing paragraphs in a Precedent via the Drafting Aide (e.g. by including or excluding option/suboption 

variables) or at a later time (see below). 

The renumbering function can work with several different paragraph label formats (and combinations of label 

formats, i.e. where several different label formats are used within one document): 

• A., B., C. 

• 1, 2, 3 

• 1.,1.1, 1.1.1 … 2., 2.1, 2.1.1 … 

• (i), (ii), (iii) 

• (a), (b), (c) 

Any time you add or remove labelled paragraphs from a Precedent and then use the Renumber paragraphs 

function, it will go through the document and renumber/resequence all the paragraph labels that are out of 

sequence (provided any added paragraphs have the same formatting/styling as other items in the same list). 

You may use the Renumber paragraphs function on its own. For example, if you filled in all the variables 

earlier, but later decided to add new paragraphs and/or remove existing paragraphs: 
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• Open the document. 

• Launch the Drafting Aide. 

• Click on the DOCUMENT REFORMAT button (if it does not open automatically). 

• Select Renumber paragraphs? in the dialog box. 

• Click the PLAY button at the bottom of the dialog box. 

 

Cross-references: please note that the Renumber paragraphs function does not resequence cross-

references (references within a document to other paragraphs in the same document) to match renumbered 

paragraphs. If you use the Renumber paragraphs function, any cross-references to paragraphs that are 

renumbered will need to be updated manually. 

 

Using the Renumber paragraphs function on documents that are not Thomson Reuters Precedents: 

please note that the Renumber paragraphs function may not necessarily work on documents other than 

Thomson Reuters Precedents. For the renumbering function to work, paragraphs must be formatted/styled in 

a particular way. Thomson Reuters Precedents are pre-edited so that the paragraphs are in the correct style 

to allow the Renumber paragraphs function to work. 

5.5.5 Save the document 

This tool will allow you to save the document at the same time as exiting the Drafting Aide. 

Return to top 

5.6 Tips/FAQs 

5.6.1 What if I’m using the Drafting Aide and I find I don’t have all the information needed to fill in a 

Precedent — can I run the Drafting Aide again later on the same document to enter the rest of 

the information? 

You may partially fill in a Precedent the Drafting Aide, and then re-run the Drafting Aide over it to fill in more 

information later (as many times as you need to). 

If you run the Drafting Aide and skip over some variables, the next time you run the Drafting Aide it will take 

you straight to the variables you did not fill in the last time. (It will do this even if previously you changed all 

the variables from blue to black text using the Document reformat tools.) 
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5.6.2 I already used the Drafting Aide to fill in all the variables in a Precedent, and now I’ve 

added/removed some paragraphs and I need to renumber the paragraphs again — can I use 

the Drafting Aide just to renumber paragraphs? 

If you run the Drafting Aide on a document where all the variables are already filled in, the Drafting Aide will 

take you straight to the Document reformat dialog box: 

 

If you wish to renumber the paragraphs, just tick Renumber paragraphs? and click the PLAY button (there is 

no need to untick the two default options that are already ticked). 

Return to top 

5.7 Troubleshooting 

5.7.1 The Drafting Aide is not enabled (MS Word 2003 or earlier) 

Sometimes MS Word decides to disable the Precedents Drafting Aide. In MS Word, click Help > About > 

Disabled Items. Disabled Items may list the Drafting Aide. You can enable the Precedents Drafting Aide by 

clicking Enable. 

5.7.2 Renumbering has not worked properly 

If the renumbering function does not work as you expected, there may be a bug in the document. Please 

contact one of the Precedents Editors: 

elani.rawson@thomsonreuters.com 

kevin.leary@thomsonreuters.com 

5.7.3 There seems to be an error in the Precedent 

Please contact one of the Precedents Editors (as above). 

5.7.4 Any other problem 

If there is anything else you need help with when using the Drafting Aide (or if you need help with any of the 

issues above), contact our Trainers through the Training & Support website: 

https://support.thomsonreuters.co.nz/ 

mailto:elani.rawson@thomsonreuters.com
mailto:kevin.leary@thomsonreuters.com
https://support.thomsonreuters.co.nz/
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The Training & Support website also offers training resources such as user guides, FAQs, tips, videos and 

webinars. 
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